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About UTM pack licences 
 

Equiinet has two 12 month subscription-based packs, UTM Standard and 
UTM Premium Protection to provide users with enhanced security and 
flexibility in a single Internet appliance. Those employing any of these 
UTM options regardless of which NetPilot hardware model they choose 
additionally have firewall, caching, VPN functionality and much more - 
built-in as standard to NetPilot. 

 

•  UTM Standard is Equiinet's terminology for its key UTM facilities and 
is available for NetPilot Lite, Plus and Enterprise. It is designed for users 
who don't need all the advanced features offered by UTM Premium.This 
includes AV for email based on Clam, anti-spam, email policy controls, 
URL filtering, advanced firewall and software upgrade service.  

•  UTM Premium Protection is Equiinet's terminology for its enhanced 
UTM facilities for NetPilot Plus and Enterprise . This pack includes all 
security elements available from Equiinet and has the most Checkmark 
accreditations of any product available. This includes AV for email and 
browsing from Sophos, anti-spam, email policy controls, URL filtering, 
Anti-Spyware, advanced firewall, IDS/IPS, and software upgrade service 

 

Note well: Version 4 or 5 software is required for the full UTM functional-
ity and for the pack licensing mechanism. Initially separate licences may 
accompany your unit rather than a single pack licence which initiates 
multiple features. 
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UTM Services – FIRST YEAR – New Products 
This table shows which models have which UTM pack subscription in-
cluded in the price of the unit – and those which require an extra cost 
upgrade. 

 

In the second you have the choice if you want to carry on with UTM 
Premium or switch to UTM Standard for NetPilot Plus or NetPilot Enter-
prise. 

 

 

Model NetPilot 
Remote NetPilot Lite NetPilot Plus NetPilot Enter-

prise 

UTM Standard 
Pack – Included – – 

UTM Premium 
Pack – – Included Included 
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Introduction 

Text Conventions in This Guide 

• Key names appear in a boldfaced type, very much the way they 
appear on the keyboard; for example, Home, End, Backspace, 
Tab. 

• When keys must be pressed at the same time, the action is rep-
resented by the key names and the plus (+) symbol; for example, 
Ctrl+Alt+Delete. 

• Drive letters that are not in command lines are presented in     
uppercase type as shown here: drive A. 

• Software directory names or folders that are not in command 
lines are presented in uppercase type as shown here: 
DIRECTORY. 

• The file names are presented in uppercase italic type as shown 
here: FILENAME. 

• The names of commands are presented in lowercase, bold italic 
type as shown here: install, or a:\install. Commands that are to 
be entered at the system prompt may be shown on a separate 
line. 

• The names of items on the desktop are presented in a boldfaced 
type. For example, you are directed to "double-click on the My 
Computer icon on the desktop". The names of software pro-
grams and items on the menu bar are also presented in a bold-
faced type. For example, you are directed to "choose Start, then 
Programs, then Internet Explorer from the menu bar". 

• When you need to type information without pressing the Enter 
key, you are directed to "type" the information. 

• When you need to type information and press the Enter key, you 
are directed to "enter" the information. 
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Further Information and Support 
Technical information relating to configuration of NetPilot is provided in 
greater depth in our NetPilot ’How To’ documents, or on our web site 
www.NetPilot.com.  The SmartStore section of the site, has additional 
hints and tips which we update on a regular basis. 

The latest version of NetPilot software can also be downloaded directly 
from our website www.NetPilot.com to a PC on your network and then 
transferred to your NetPilot unit. We recommend that you check this site 
regularly for the latest upgrade. 

To enable you to download upgrades, you must have first registered your 
unit, and this can also be done on the same web site. 

For first line telephone support, please contact your NetPilot product sup-
plier. 

Useful URLs 
Equiinet 
www.Equiinet.com 

 

Online Help for UTM Services Registration  
http://www.netpilot.com/register/help_new/utm_help.asp  

 
Online Information on UTM feature  
http://www.equiinet.com/netpilot/unifiedthreatmanagement/default.asp  
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Checking you have the correct Option and Unit 
 

Before attempting to install the UTM Standard or UTM Premium option, 
please check that you have the correct option for your particular NetPilot 
model, and that your model is capable of running this software option.  

 
 
To identify which model product you have:  
http://www.equiinet.com/netpilot/support/idyournetpilot.asp  

 

Physical or Electronic Pack contents 
You may be dispatched a physical pack containing licensing and 
documentation, or an electronic copy of these may be emailed to you 
(to save time and shipping charges!)  

Your pack should contain: 

• This Getting Started Guide 
• Proof of Purchase (POP) Code 
• Licensing and Copyright Information if appropriate 

 
If any of the items are missing, contact the Equiinet Limited re-
seller from whom the option was purchased. 

 

Proof of Purchase (POP) Code 
 

This is a very important code and should be kept recorded in a suitably 
safe place. The Proof of Purchase (POP) code, is used during the Li-
cence Installation sequence. If the POP Code has been emailed to you, 
exercise the same care in retaining this important data. 

Before you start this procedure you will need the Serial Number and 
MAC address of your NetPilot. These are found on a label on the under-
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side of your unit. For ease of reference write these numbers down, to-
gether with your supplier information and POP code. 

At the end of the Licence Installation sequence the actual Licence Code 
will be displayed. Also write this down along with today’s date and all the 
other information mentioned above. 
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Licence Installation 

Installation Requirements Check List 

Before you start you will need:  
 

- POP Code.   

- The serial number of your NetPilot 

- A PC with a browser, linked with ADMIN access to your NetPilot.  

- The NetPilot must be configured correctly to access the Internet be-
fore you attempt to enable licenced functions. 

 

Note: If you are an End User and having read through these instructions 
you don’t feel confident of undertaking this exercise, please contact your 
supplier who can arrange for a trained engineer to do this for you. 
 

Online Help for Registration 
Further information is available regarding this process on: 

http://www.netpilot.com/register/help_new/np_help.asp  

 
Finding out a unit’s MAC Address 
This is usually not required when registering directly on your NetPilot. 

If you are registering using the online NetPilot.com system (without the 
NetPilot being present) you will need the unit’s MAC address. 

This can be obtained if you have ADMIN access to your unit (rather than 
by viewing the label attached to the device). 
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• Logon on as ADMIN. 

• Click on Maintenance left hand button. 

• Click on Network top button. 

• Click on Interface List link.  
 

The first Entry should be LAN (eth0): and its set out as : 
NN:NN:NN:NN:NN:NN 

You can type this into the field with or without the ':' delimiters directly 
into NetPilot.com registration pages.  
 

There is no software mechanism for viewing the unit’s serial number. 
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Adding a Licence Key to NetPilot - Next Steps  
 

The following steps show how to enable your NetPilot with the necessary 
Licence Key for a UTM Service.  
 

The UTM Services package you have purchased, entitles you to a one-
year subscription. Prior to the end of the subscription period you will be 
reminded that renewal is required. 

 

The serial numbers, Proof of Purchase codes and Licence codes given 
below in the following screens are examples only. These will not actually 
operate any UTM Services. Only use the Proof of Purchase code deliv-
ered/emailed in the UTM Service pack.  

Step 1: Adding a Licence – Advanced Admin 
 
- Log on as ADMIN. 

- Go to the Maintenance > Advanced > Licence Management 
screen. 

- Click Add as below: 
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Step 2: Adding a Licence – Enter Licence Management details 
- On Clicking Add you will then see the screen below. 

  

 
- Fill in the details in the first 2 boxes then the fourth box : 

o The Serial Number off the label either on the bottom or back 
of the NetPilot unit.  

o The ‘Proof of Purchase’ (POP) code off the Certificate 

o In the fourth box enter the email address of the administra-
tor of this unit. The email address must be an email account 
present on this unit.  
 

- You don’t yet have a Licence Key (this process is going to give you 
one) so leave the third box blank and Click OK.  

Note for advanced users: If you have already registered and ob-
tained a Licence code via the registration web interface: 
http://www.netpilot.com/register/  you could enter a previously ob-
tained licence code at this juncture.  
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Step 3: Adding a Licence – Confirm Codes 
 
- The screen below confirms what you typed in.  

- If it is correct click OK, otherwise click Cancel. 

 
 



Licence Installation 
 

 

14                  Getting Started – UTM Email 

Step 4: Adding a Licence – Input your name and address 
 

- You are automatically re-directed to the web site www.NetPilot.com.  

- Fill in all the name and address type details. It is essential that you 
enter the correct number of users on your network. Click Continue. 

 
 

- Fill in a second screen with the name and email address of your 
supplier and Click Continue. You will receive an email confirming all 
the details entered. You will then be directed back to your NetPilot.  
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Step 5: Adding a Licence – Configure Licence features 
 
- Once you have returned back to your NetPilot, you then will get a 

confirmation that the NetPilot has added the licence. 

- Click Next, to configure licence features. 

 
If the settings for the UTM services you are adding is set to ‘not config-
ured’ change it to ‘enabled’  
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- Click OK and additional options applicable to the enabled UTM ser-
vice will become available within the interface. 

 

 

If at any point you wish to disable a service select ‘not configured’ from 
the drop down menu and the additional options will be removed from the 
interface.  
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Deleting, Editing and Confirming a Licence 
 

These screens can be used at the end of the initial licence period. If you 
decide not to renew your subscription – delete your licence code. This 
will stop email reminders being sent. 

Step 1: Deleting, Editing and Confirming a Licence 
 
- Log on as ADMIN. 

- Go to the Maintenance > Licences > Add or Remove screen. 

- Select the Licence you require (there may be multiple) to Delete or 
Edit (to confirm details) and click the appropriate button. 
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Step 2: Deleting a Licence 
 
- If you select the Delete option you will be asked for a confirmation 

prior to deletion.  
 

- Click OK again, to complete the deletion sequence. 
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UTM Email Services – Overview 
 

Anti-Spam 
The NetPilot UTM Anti-Spam component provides a powerful combina-
tion of countermeasures including Spam Assessment (based on the 
award winning Spam Assassin technology), several databases of known 
spammers including Spam Cop, together with Bayesian learning. 

Anti-Virus for email  
Anti-virus capabilities are powered by Sophos for UTM Premium and by 
Clam for UTM Standard, offering a gateway anti-virus scanning of all in-
coming, outgoing emails. Unlike ISP operated anti-virus services, the 
Equiinet's UTM anti-virus solution checks all mails being sent between 
users internally within the organisation – not just email coming from ex-
ternal sources. Further, it checks all email accounts coming from all ISPs 
– not just the single ISP selling you their service and even better regard-
less of whether the email is POP, SMTP and potentially even hotmail 
web based!  

Email Policy Controls  
Mail policy controls give the administrator even greater scope to create 
more extensive rules to deal with email, customized to your organisa-
tion's needs.  
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ANTI-SPAM Facility - a two tiered ap-
proach 
NetPilot offers a two layered approach with Anti-Spam controls, with both 
having been integrated to provide common controls and reporting.  Firstly 
by adding the Anti-Spam Licence the NetPilot provides Spam assess-
ment and Spam Cop together with Bayesian learning, giving a powerful 
combination of standard spam countermeasures. Together with the  
Email Policy this can additionally provide additional quarantine, black and 
white listing, and much greater flexibility to handle spam.  

Standard Anti-Spam Controls 

Firstly NetPilot uses Spam Assessment. With this counter measure, 
emails are scanned against a pre-loaded set of over 926 Spam charac-
teristics and allocated a score based on the likelihood of it being Spam. If 
the email rates more than an Admin definable threshold on this grading 
scheme, it is flagged up as Spam. Spam Assessment can delete the of-
fending message before it arrives at the desktop and send a message to 
the sender to inform them the message has not been delivered.  

NetPilot can optionally and additionally use SpamCop as a global unit 
wide defense against Spam – predominately running checks on incoming 
email against databases of known Spammers. This offers the network 
manager a very easy to deploy Anti-Spam measure with proven 99% 
success rates. SpamCop checking needs to be enabled if you wish to 
use this feature. The impact on finding a match in the SpamCop data-
base is for the email’s spam score to be incremented by 3 points, and 
then passed to Spam Assessment for further scanning. These two 
stages of scanning need to exceed the discard threshold for deletion or 
the suspect threshold for quarantine action to occur. 

With both these options there is no requirement to necessarily 
modify any aspect of the client PC operation. However, the ranked 
message can be passed on to the inbox where the user can establish a 
separate folder for suspect emails. This allows the user to enter this 
folder at his leisure and briefly scan the message titles before deleting. 
Spam Assessment offers high levels of success against Spam, but does 
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require some email client configuration if you wish to use the system’s 
full flexibility.  

Bayesian filtering 

This is a mathematical approach that, unlike many other anti-spam tech-
nologies, adapts over time and takes the changing strategies of spam-
mers into account.  It therefore offers moving goal posts which obviously 
make it far harder for the spammers.   

Central to Bayesian filtering is the principle that the likelihood of events 
happening in the future can be inferred by analysing past events.  Spam 
emails are therefore likely to be made up of similar elements, while valid 
emails (sometimes referred to as ‘ham’) will have their own determining 
characteristics.  Bayes classifiers learn as they go, updating both the 
rules and the scores so that when a new evasion trick comes along, the 
message may still have enough other bad features that the filter will rec-
ognise it as spam and if so, the system will learn the new trick automati-
cally.  If it should happen that the message is sufficiently different from 
any previous spam that it gets through, it is up to the recipient to tell the 
system that it made a mistake. 

The characteristics of both spam and ham, however, will vary between 
organisations.  A pharmaceutical company, for instance, may have the 
word ‘Viagra’ appearing quite frequently in the valid emails it receives, 
while for other companies the same word often denotes spam.  Unless 
there is an acknowledgement of these different sorts of characteristics in 
companies’ email traffic, it is very likely that genuine emails will be misin-
terpreted as spam by spam filters, resulting in false positives. 

It is essential, though, for the Bayesian filter to be given a period of time 
to analyse a company’s incoming and outbound mail in order to make 
tailored Bayesian word databases for both spam and valid mail.  By 
comparing outbound mail and known spam, all words and tokens can be 
given a probability value as to whether an individual word is an indicator 
that the email is spam or non-spam (ham). 

The fact that these databases are tailored to the company is vital.  To 
take our earlier example further – if the word ‘Viagra’ often appears in the 
company’s outbound mail and incoming legitimate messages, the system 
will recognise that for this particular company the word does not neces-
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sarily increase the likelihood of a message being spam, and the danger 
of the word generating false positives will be lessened.  

Whilst a period of at least two weeks’ initial learning is required before 
the filter should be considered usable, the system will of course keep 
improving over time as it learns more about the characteristics of the 
company’s legitimate email and spam.  In addition to this tailored learn-
ing process, a good Bayesian filter will also include a pre-loaded file of 
known spam which should be updated regularly to take account of recent 
activities by spammers.   

After the learning period, when an email arrives the words that are most 
likely to appear in a spam message are identified by the Bayesian filter, 
as well as those which most commonly appear in ham messages.  These 
two elements are then balanced against each other and the probability of 
the whole message being spam is calculated: a much more sophisticated 
technique than merely using keywords, where an email from a known 
contact could be mistakenly identified as spam because it contained the 
word ‘free!’.   

The positive or negative score contributed by the Bayesian system is 
then used to score the message according to good and bad factors.  If 
the Bayes system is really sure the message is spam it adds a big score 
(+5), while if it is certain it is ham it subtracts a similar value.  The values 
in the scoring system have been carefully adjusted so that a total score 
of 0 means the email is almost certainly ham while a score of 10 means it 
is almost certainly spam. 

The system administrator can then optionally set thresholds: a lower 
threshold, so that email with a score below it is delivered automatically, 
or an upper one, so that email is discarded automatically. The default 
setting of NetPilot allows for both thresholds to be set, so that any mes-
sage with a score in between may be placed in quarantine, diverted to 
someone for human inspection, or passed on to the recipient with the 
spam-score marked in the message header.  This approach works much 
better than using a single threshold, since the NetPilot gets the opportu-
nity to ask for help on any messages where the validity is unclear.  

The relative importance of Bayesian filtering used in combination with 
other anti-spam techniques, therefore, changes with experience.  The 
Bayes system has an idea of how much it has learned, so as well as say-
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ing whether a message is spam or not, it can also say how sure it is.  
Initially, before the training process, the Bayes system isn’t confident and 
contributes nothing to the spam score.  But it learns quickly and soon 
becomes so confident that it can out-vote the old fixed-rule method.  
Even when the Bayes classifier is well-trained, however, the fixed-rule 
score still makes a useful contribution.  It is particularly helpful, for in-
stance, when the Bayes system is faced with a really unusual message 
unlike any it has seen before. 

One of the best ways of combining Bayesian filtering with other anti-
spam techniques can be seen when used in conjunction with the Email 
Policy Licence. This allows for all message attributes to be learnt and for 
the Administrator to reclassify incoming emails as Spam if necessary.  
Although this may seem an onerous task, it is only a relatively short one 
and the results are very worthwhile.   

In addition each time the system lets through a spam message, it is im-
portant that the individual user feeds that information back to the system 
using the ‘X-Spam-ReClassify:’ link in the message header.  The Bayes 
system will then learn any new keywords it missed and update its idea of 
how best to tell the difference between good and bad messages. 

Once this user and administrator combination has re-classified sufficient 
messages – perhaps two weeks’ worth, or a couple of hundred emails – 
the training starts to pay off and the number of Spam messages will be 
found to decrease noticeably.   
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Anti-Spam Facility - Controls 
 

NetPilot’s standard Anti-Spam option offers a number of facilities which 
can be deployed either in tandem or individually depending on require-
ments. Further controls are available in conjunction with Email Policy 
Controls.  

 

Anti-Spam Facility – Spam Assessment Controls 
Enabling/Disabling Spam Assessment is controlled by the following 
screen in Email > Spam > Spam assessment. 

 



Anti-Spam Configuration 
 

 

Getting Started – UTM Email 25 

The Spam threshold control screen in Email > Spam > Spam threshold 
(below) offers the options to:  

 
• Set the discard threshold - The default level is set to 9. Once the 

unit has benn trained to recognise between a company’s spam 
and ham requirements we recommend changing this threshold to 
5. So any incoming email scoring 5 or greater will be immediately 
deleted. This option may be configured to never discard. 

• Set the Suspect Threshold – Before setting the suspect thresh-
old a set of actions controlled by radio buttons is provided, which 
are applied if incoming emails are above the Suspect and be-
low the Discard threshold. Actions are: 

o Divert it to the named “admin” email account 
o Divert it to the named “admin” email account as attach-

ment 
o Deliver anyway (default). In this mode the email would 

then be assessed by the email client. 
o Or if the Email Policy is operational to quarantine the 

email. 
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The settings in the screen, will discard emails above 9, flag suspect 
emails between 1 and 9 as Spam for Email client handling only, and will 
deliver anyway. 

 

On the other hand the example below shows that anything with a score 
above 5 will be discarded, 1 and above will be quarantined if Email Policy 
is active and emails below 1 will be delivered to the recipient. With 
Bayesian and Email Policy active this is the recommended setting after 
the system has been trained to recognise between Spam and Ham. 

 

Anti-Spam Facility – SpamCop Controls 
The SpamCop control screen offers the options to enable/disable use of 
the SpamCop database (Enabled as Default). 
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Anti-Spam Facility – Report Spam 
The Report Spam screen in Email > Spam > Report Spam allows you 
to change the way the Anti-Spam Bayesian filtering system views a par-
ticular type of incoming email. 

To reclassify from ham (good) to Spam (bad), you need the Message ID.  

 
 

Finding the Message ID 

This can be done in one of two ways: 

• Looking at the email with Outlook and finding the Message ID 
from the email’s header. (see next) 

• Looking at the Review and Learn Administration Screen (see 
next) if you additionally have an Email Policy Licence enabled. 

With Outlook, when the email is displayed it is possible to see the email 
header by selecting the top menu item View and then selecting Options 
from the drop down menu options. 
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You can find and then select the reclassification string within the header 
in the format of: https://domain_name_of_your_netpilot/secure-
admin?mod=spamassin-relassify&mid=xxxxxxx,xxxxxxx 

It is then possible to copy and paste the MID string to your browser and 
go through the reclassification of ham to spam as shown next. 
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Clicking OK will change the status of this email from ham to spam (see 
below). More importantly this also tells the Bayesian learning mechanism 
within the NetPilot’s Anti-Spam software to rate any further similar emails 
as to be more likely spam than ham. 

 

 
The screen below confirms the reclassification for this email.  
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Anti-Spam Facility – Bayesian Learning 
The Bayesian filtering will not commence until the system has learnt 200 
Spam and 200 examples of good emails – ham. 

An example of a newly installed licence is shown below in Email > Spam 
> Spam and Ham learnt – with as yet nothing learnt. 

 
 

The example below shows a system which has seen and learnt over 300 
spam and 5000 ham emails. 
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Saving your Bayesian Filtering Database  
Login as admin and go to Maintenance > Backup > Make backup, to 
backup your Bayesian filtering database. If you swap your unit without 
restoring this information you will have to retrain you system from 
scratch. 
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Changing the Email Administrator’s address and ob-
taining statistics 
 

• Log on as ADMIN. 

• Select from the side bar menu Email > Email Administra-
tor.  

 
• To obtain Filter reports for Anti-Virus activity and optionally 

Anti-Spam use the Filter Report link. 

The screen below shows output of the Filter Report for Anti-Spam activ-
ity. The report details email traffic by Spam Assessment score. 
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Spam Assessment Outlook Email Client Configuration 
NetPilot SPAM assessment alters the header of incoming emails to indi-
cate to the email client that it has allocated a particular score using its 
inbuilt assessment criteria. If the incoming email scores more than the 
unit’s configured threshold, then it will flag “YES” that it believes the 
email is indeed SPAM. Regardless of this flagging, the score is ap-
pended to the email header and can then be used by the email client 
such as MS Outlook to determine how to handle the email.  
 
Note: If you do not wish to modify email clients (and many don’t) the al-
ternative  is to use global Spam assessment settings for the whole NetPi-
lot unit, whereby a threshold is used and incoming emails over it are de-
leted or quarantined  on the NetPilot, as showed earlier in this document. 
If an Email Policy has been employed then suspect Spam can be quar-
antined for Admin review or indeed handled in differing ways for differing 
users.  

 
Currently, the standard version Outlook can create and act on ‘rules’ re-
garding an email header – but although Outlook Express has the concept 
of rules they do not allow use with email headers – so it is not suitable for 
this application. 
 

To act on client rules, the Administrator will need to configure each at-
tached PC, or provide information to the attached users, as to how email 
clients must be configured. This is a straightforward process and allows 
each individual user to tune exactly what thresholds to use and then what 
to do with the offending emails. Typically, incoming suspect emails would 
be quarantined into an appropriately named subdirectory e.g. ‘Suspect 
SPAM’. The individual recipient can then quickly review sender/subject 
and manually delete blocks of emails. Alternatively the recipient may 
care to create more sophisticated rules whereby very high scoring emails 
are immediately deleted, but perhaps more marginal are left for quick 
review in the quarantine area. This rule setting needs to be adopted in 
accordance with the needs of the particular user . 
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Prerequisites for Email Client Configuration 

 

This section assumes you have: 

  

- A PC with Outlook email client access to/from your NetPilot. 
 

- The NetPilot must be configured correctly to access and re-
ceive/send email via the Internet. 
 

- You have gone through the ‘Adding a Licence’ Section above. 

 

- You wish to implement the granularity of SPAM controls for individ-
ual users. If you do not wish to modify email client settings as ex-
plained above either : 

• Use the global unit Spam Assessment threshold and delete 
or quarantine email for all users above this threshold. 

• Or just use SpamCop, or enable SpamCop and instigate a 
global Spam Assessment threshold as well. 
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Step 1: Checking headers are being amended by NetPilot 
 
- Go into your Outlook Inbox, Click on and into an email that has been 

received after the SPAM Assessment Licence has been added. 

- Go to the View tab, and select the Options item from the drop down 
menu. You will see the screen as below. Notice the header lines 
starting X-Spam-Level. This shows that SPAM assessment is opera-
tional on the NetPilot, and the individual email in this example has 
scored -4.8, and is classified as NO (not a Spam). Note the Spam 
message within the header has a setting of “29-14-D2”. This repre-
sents part of the MAC address of the NetPilot LAN1 Port1. This en-
sures that Spammers cannot spoof these headers. If you are creat-
ing rules to search for these strings the MAC address will have to be 
contained within the rule – but will be consistent in its value – so 
your rule will continue to work once established. 
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Example Header 

In this example SPAM Assessment is operational and the incoming 
email has obtained a score of 4.4. The relevant parts of the header are 
shown. 

In this case it is not a particularly obscene or worst case SPAM, just a 
typical example of mildly annoying email. Hence the suggestion that 
anything scoring above 5 should be deleted immediately on the NetPilot, 
anything between 1 and 4.9 be passed to the user for review. This may 
cut down the recipients email management time. 

 

> 
From: "Jennie Presley" <HILNDV@xtra.co.nz> 
To: dabbot@equiinet.com 
Subject: Depressed? We can help. 
Date: Tue, 02 Nov 2004 18:44:17 -0200 
X-Mailer: optometry restful 
concretion-automat: tariff clap buyer 
MIME-Version: 1.0 
Content-Type: multipart/alternative; 
           boundary="----=_NextPart_000_000A_8226E28O.2E7KD82D" 
X-Email-Filter-29-14-D2: 3.1.5RC0 netpilot.equiinet.com 
X-Spam-Level-29-14-D2: **** 
X-Spam-Checker-Version-29-14-D2: SpamAssassin 2.64 (2004-01-11) 
on  
 netpilot.equiinet.com 
X-Spam-Flag-29-14-D2: YES 
X-Spam-Status-29-14-D2: hits=4.4 
 tests=FORGED_RCVD_NET_HELO,HTML_MESSAGE, 
 MIME_BOUND_NEXTPART,RCVD_IN_NJABL_PROXY 
autolearn=no version=2.64 
X-Spam-Key-29-14-D2: (4.4 points in total) 
X-Spam-Key-29-14-D2: 0.0 HTML_MESSAGE           BODY: HTML in-
cluded in message 
X-Spam-Key-29-14-D2: 3.0 FORGED_RCVD_NET_HELO   Host 
HELO'd using the wrong IP network 
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X-Spam-Key-29-14-D2: 1.2 RCVD_IN_NJABL_PROXY    RBL: NJABL: 
sender is an open proxy 
                            [220.119.154.245 listed in combined.njabl.org] 
X-Spam-Key-29-14-D2: 0.2 MIME_BOUND_NEXTPART    Spam tool 
pattern in MIME boundary 
 
X-Spam-Reclassify-29-14-D2: https://netpilot.equiinet.com/secure-
admin?mod=spamassassin-reclassify&mid=1099428999.2269217998 
 
X-Virus-Checked-29-14-D2: 0 Anti-virus engine 3.85.0 R1, released 04 
October 2004, 95634 virus identities. 
 

 

Notice the highlighted Reclassify string within the header. This may be 
used to teach the Bayesian filtering mechanism that this email is Spam 
The string can be copied and pasted into a browser window and the 
user can then get to the Report Spam screen where he can reclassify 
the above email.  

Besides SPAM assessment the email was checked for viruses. 
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Step 2: Create a Folder for incoming Suspect SPAM 
 
- Go to the View tab, and select the Folder List option from the drop 

down menu.  

- Click on Inbox 

- Go to the File tab, and select the New option from the drop down 
list, then select Folder. Create a meaningfully named new folder 
such as ‘Suspect SPAM’, and Click OK. 
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Step 3: Create a SPAM handing Rule 
 

- Click on the Inbox on folder list. Select Tools tab, and the Rules 
and Alerts option from the drop down menu. 

- Click on New and create a new Blank Rule. 
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Follow the Wizard’s guidance. Create a rule that operates after a mes-
sage arrives, and under a condition which looks within the message 
header for the text ‘X-Spam-Level-29-14-D2: **’. 
 
Using a number of asterisks in your match string will match all Suspect 
SPAMs with a score of over 2. However you may wish to create addi-
tional, slightly more advanced matches for emails with say a score of 
over 4 which would immediately delete the offender. 
 
For the next and final rule in our simple example, instruct the system to 
move any email matching the first rule to your newly created Suspect 
SPAM folder for later human review. 

Step 4: Testing your SPAM rules  
 
- Ensure you have some email in your Inbox that has appropriately 

high SPAM Assessment scores. 

- Click in the Inbox on folder list. Select Tools tab, and then the 
Rules and Alerts option from the drop down menu. Click on your 
newly created rule. 

o Click on Run Rules Now 

o Click the tick box appropriate to your rule 

o Click on Run Now 

- You will now see the offending emails being moved 
to the Suspect SPAM folder. 

- If no files end up in this folder check the syntax of 
your rule and match strings, and recheck you have 
suitable candidates in your Inbox. 
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UTM Anti-Virus for Emails Configuration 
 

Prerequisites for Configuration 
 

This section assumes you have: 

  

- A PC with browser link with ADMIN access to your NetPilot. 
 

- The NetPilot must be configured correctly to access the Internet. 
 

- You have gone through the ‘Adding a Licence’ section. 
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Enabling/Disabling Anti –Virus Scanning 
Select the Configuration link form the Virus section under Email and 
disable or enable virus scanning. This will be set as default to active. 
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 Configuring Anti –Virus Scanning 
- The Virus redirection and settings screen is shown below. To view it 

go to Email > Virus > Redirection.  

 

 
 

- The first radio button box allows you to configure what action should 
be taken on finding a virus: to discard it (default), to redirect it in the 
virus admin mailbox (the administrator must have the knowledge 
and tools to deal with it!), or to deliver the infected email anyway. A 
further option to quarantine will appear if Email Filter Policy is en-
abled on the unit – as shown above. 
 
See Email Policy sections for more information on controlling 
emails. 
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- The next radio button box allows you to configure what action 
should be taken on finding a file that cannot be opened (e.g. it is en-
crypted and potentially might carry a virus): to discard it (default), to 
redirect it to the virus admin mailbox (the administrator must have 
the knowledge and tools to deal with it!), or to deliver the infected 
email anyway. A further option to quarantine will appear if an EPF is 
enabled on the unit. (This virus scanning option is currently available 
for Sophos anti-virus only and will be made available in later re-
leases for UTM Standard AV.)  
 

- The next box defines the virus admin email mailbox to be used to 
divert emails containing viruses.  
 

- The next set of tick boxes defines who gets email notification on vi-
rus detection or failure to scan an email because of inability to open 
it (because of encryption etc). Any combination of the ‘recipient’ and 
‘Admin’, or neither is allowed.  
 

- The next text confirms the email account being used for virus ad-
ministration messages.  
 

- Click OK when you have completed your configuration. 
 

Note you need to go and clear you ADMIN email account periodically – 
otherwise at some point you will fill your hard disk!  
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 Checking the Virus Engine Status 
- This screen shows the version number and month of the Sophos 

Anti-Virus Engine that is currently loaded onto the NetPilot. You 
can view it under Email > Virus > Sophos engine status. 
 

 
 

- As default an Engine is loaded onto each NetPilot, and when the li-
censing conditions are satisfied it becomes active. The NetPilot will 
automatically contact a remote Internet server to obtain any update 
to the checking Engine and any new (interim) Virus Identities – 
known as IDE files. The NetPilot makes this check automatically on 
installation and configuration of the UTM option and then subse-
quently several times during every 24 hour period. 

NetPilot will automatically update this, but the administrator/installer 
should ensure that an Engine relevant to the current month has 
been loaded within a 24 hour period.  

The Administrator can determine if the upgrade has occurred by in-
specting this screen or by reviewing the Upgrade Management logs. 
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It is possible to use the Upgrade Management tools to manually ini-
tiate an immediate download and upgrade of Engine and IDE files. 
See next Section. 

Each month Sophos releases a new Engine and this incorporates all 
previous months’ IDE files, so the number of IDE files will increase 
as the month progresses. 

- Click OK when to complete the status review.  
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 Testing a file (and the Engine) 
 

- The final option in the Virus section is Virus Test.  
 

- This enables the administrator to define a single file specification (no 
multi-file wild cards possible) on a PC or Server that he wishes to 
check for viruses. The file is automatically copied to the NetPilot and 
scanned. This serves 2 purposes, firstly to check if the Engine is 
working on the NetPilot, and secondly to check the integrity of a 
suspect file.  
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Example email on finding a Virus 
 

The following screen shot is of a warning email from the NetPilot stating 
a virus has been found. The email header has been included so the 
sender can be traced.  
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Verifying an email has been scanned by NetPilot 
 

The following screen shot is of an email header, of an email that was 
scanned by NetPilot. 

This confirms that NetPilot used engine 3.87, released on 1st Nov 2004 
and 96552 virus identities were checked! 

To see an email header under Outlook, view the email, select top menu 
View and select Options from the drop down menu. 
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Changing the Email Administrator’s address and ob-
taining statistics  
 

• Log on as ADMIN. 

• Select the side bar menu Email > Email administrator.  

• You can change the default email administrator by entering a 
different email address in the Administrator email entry field. 

 
 

 

• To obtain Filter reports for Anti-Virus activity and optionally 
Anti-Spam use the Filter Report option as shown below. 
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The screen above shows output of the Filter Report for Anti-Virus activ-
ity. This simple example shows one virus detected – the EICAR test vi-
rus. 

 



Anti-Virus for E-mail 
 

 

52                  Getting Started – UTM Email 

Testing the EMAIL Virus Scanning Mecha-
nism 
 

This enables the Administrator/Installer to test that the NetPilot system 
correctly sees, stops and notifies the defined parties that a Virus has 
been received. To enable the test - go to the NetPilot.com web site using  
the URL: 

http://www.netpilot.com/virus_tester/index.asp  

The Administrator/Installer is prompted to enter both the serial number 
and the MAC address of the NetPilot unit under test. Note this facility will 
only send its virus test data to a NetPilot unit that has been correctly reg-
istered for UTM Licence. It will send the test email to the administrator 
account registered during the process described above in the ‘Adding a 
Licence’ section.  

 
 

 
 
On entering the Serial Number and MAC address of a previously regis-
tered unit with UTM Anti-Virus the second page will be displayed:  
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This page describes the test process and that you acknowledge what will 
happen. Click Continue if you are happy to proceed. The page text is 
given here for clarity: 

“By clicking below, you authorise Equiinet to email you a copy of the Ei-
car.org test file. The file does not contain a destructive payload, and will 
not cause any damage to your computer system. The file contains text, 
which is identified by Sophos Antivirus as a test virus, and the email at-
tachment should be cleaned.  
 
The EICAR organisation (or European Institute of Computer Anti-virus 
Research), along with anti virus vendors, has developed this test file to 
assist users in testing their installations of anti virus software. It is rec-
ommended that vendors detect this file.  
 
This is NOT A VIRUS. The file is a test file, which may be used to test 
anti virus software. The code is harmless and when detected properly 
the virus scanner will display the following message: EICAR-TEST-FILE  
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However neither Equiinet Ltd or the site hosts (Smartways Technology 
Ltd) take responsibility for any damage caused to your systems through 
the use of this facility. It is provided for Equiinet customers with no sup-
port. More information on the Eicar Anti-Virus test file, please click here. 
 
By clicking continue, you signify that you have read and agree to the 
above disclaimer.”  
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Anti-Virus Upgrade Management 

Background 
The Upgrade management screens are used in a much wider context 
that just Anti-Virus Scanning. The information given in the section ‘Up-
grade Management and Forcing Immediate Update on Anti-Virus Scan-
ning’ below covers the relevant screens that impact Anti-Virus Scanning.  

More general details on Upgrade Management are covered on the next 
two pages. To access the Upgrade Management screens go to Mainte-
nance > Advanced > Upgrade Management. 

Configure auto-upgrade 

In order to use the upgrade system, you first need to decide one of the 
following for each type of upgrade (configure this in the "Configure Auto-
upgrade" screen):  

Auto-Install:  This downloads and installs all upgrades automati-
cally, without user intervention.  

Timed Install:
The unit will download and install all upgrades within 
the selected time bands. 

Download:  

This downloads upgrades automatically, but requires 
the user to select which upgrades to install on the 
"upgrade selector" screen.  

Off:  
The unit will not do anything for this type of upgrade.  
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Unless you have selected 'Off', you can check the upgrade site for new 
upgrades manually at any time by pressing the Update button on the 
"configure auto-upgrade" screen. New upgrades will be downloaded onto 
your NetPilot. If you have 'Download' set, you will then need to select the 
upgrades for installation on the "Upgrade Selector" screen.  

 

Upgrade selector 

On this screen you will see a list of upgrades and their statuses. If an 
upgrade is suitable for your system, you can select it for installation by 
checking the appropriate box. If an upgrade has failed installation, you 
will be given the following choices:  

Do nothing:  Do nothing.  

Retry:  
Try to install the upgrade again.  

Delete:  
Remove the upgrade from your system permanently 
(use with caution).  

Upgrades selected for installation and upgrades in progress will also be 
shown on this screen.  

To start the selected upgrades press the "OK" button, or you can press 
"CANCEL" to go back to the upgrade main menu. If upgrades have been 
selected for installation, you will be taken to the "upgrades in progress"
screen. To check that the upgrades are successful, you can go to the 
"upgrade history" screen.  
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Upgrades in progress 

This screen allows you to view which upgrades are in progress, and 
which are selected for installation. You will always be able to see details 
of the last attempted upgrade here.  

 

Upgrade history 

This screen shows all attempted upgrades - both successes and failures, 
and their appropriate logs.  

 

Upload new upgrades 

If you have an upgrade on a floppy disk, CD, or stored on your PC, you 
can upload it into the upgrade system via this screen. Just press the 
"Browse" button and navigate to the upgrade, then press the "OK" but-
ton. If the upgrade is valid, it will be installed straight away. 

 

Upgrade Times 

Select the time band during which upgrades can be installed 

 

Upgrade Polling Logs 

Logs for the upgrade polling mechanism 
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Upgrade Management and Forcing an Immediate Up-
date  
This section deals with forcing an upgrade of Engine/IDE files for Anti-
Virus Scanning. 

Step 1: Configure Auto-Upgrade screen 
 

- In Maintenance > Advance > Upgrades > Auto-upgrades you 
should see ‘Virus-Scanning Upgrades’ set to Auto-Install. This 
means that the NetPilot will test for new updates between 1 and 3 
hour periods depending on WAN type and auto-install them auto-
matically. 

- To manually force an immediate update - click the Update button. 
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Step 2: Upgrade Selector screen  
- This screen will describe what upgrades are available. If an upgrade 

has failed installation, you will be given the following choices: do 
nothing, delete or retry. 

- Make your choice and click the OK button at the bottom of the page. 
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Step 3: Upgrade progress screen 
- This screen describes what upgrades are currently in progress.  

 

- Clicking the Update button will refresh the information on this page. 
After a few minutes you will get a message with the last line saying 
‘Succeeded’.  
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UTM Emails Policy – Overview  
The Email Policy functionality is a licenced component for NetPilot and is 
part of the UTM packs. 

It provides the Administrator with great flexibility to control emails in ways 
he/she defines, depending on attributes of the email including: 

 

• The Header of the email  
• The recipient 
• The sender 
• The subject 
• The email size 
• etc. 
• The body of the Email 
• Email Content - specific text or patterns 

 

So what are the types of things that can be done with this flexible Email 
Policy control mechanism? 

• Add a specialised email footer depending on 
sender/recipient 

As standard NetPilot can add footers for everyone - but you 
may want tailored footers for say your sales department giv-
ing latest offers! 

 

• Quarantine any email with an attachment 

Some companies don't like the concept of attachments com-
ing in or going out of their organisation without review - The 
administrator can intercept and authorise delivery. 
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• Quarantine or just delete any incoming HTML mail! 

One company took the view that if anyone wants to email 
them it had better be in plain text - because their policy is to 
instantly delete HTML mail. 

 

• Quarantine or delete emails over a certain size 

Sending an email out with a very large attachment may have 
seemed like a good idea to one user who gives no regard to 
what it does to his colleagues' network response. Quarantin-
ing the email for overnight transmission is now possible. 

 

• Create "out of office" auto responder messages with addi-
tional actions 

A simple responder message can be easily configured - but 
also perhaps you would like to forward emails from just key 
customers or the boss to an 'out of office' mailbox, and op-
tionally keep or delete email destined for the normal mailbox. 

 

• Block particular domains or users sending email 

Plagued by emails from certain sources? Blacklist them so 
they don't get through to all or just certain of your users. 

 

• Be absolutely assured you get email from certain domains or 
users 

Worried that that key customers' email might be trapped as 
Spam, because they will insist on using HTML and other 
Spam like characteristics. Whitelist the domains of your cus-
tomers and your own staff - so you know the important peo-
ple get through! 
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• Forward email defined by domain (or sub-domain), or 
sender/recipient to a particular back end email server. 
 
You are a bigger organisation scanning incoming mail cen-
trally, but want emails sorted to be onward routed to particu-
lar Exchange servers - all possible! 

 

• Block outgoing external emails from certain users - but allow 
internal mail. 

You may want some users to be able to only email their in-
ternal colleagues and no one externally. You may want to 
trust some other users a little further so they can send exter-
nal emails but you want a copy of everything they send and 
receive, and finally you also want other users who are com-
pletely unrestricted and unmonitored. All possible! 

 

• Take copies of all emails coming from external addresses - 
but ignore all internal office messages. 

Some organisations want or have to backup all communica-
tions with external clients, but want to avoid backing up in-
ternal email chatter. 

The Email Policy system works also in conjunction with other UTM ser-
vices which deal with email - in particular Anti-Spam and Anti-Virus. 
When either of these two services discovers an incoming (or outgoing) 
email which is deemed to be infected with a virus or is spam, they can 
quarantine the email, which is where the Email Policy system can take 
over. Additional rules and controls used by the Administrator can then be 
initiated. The Email Policy can also be actively employed as a second 
tier of checks. For example after (or even before) an incoming mail has 
been checked for the usual spam characteristics you could decide that 
any email coming from a known source - say your customers - would 
always be treated as ham (good) messages, regardless of the content. In 
this fashion you are creating what is known as a white list. The exact op-
posite could also be set up, say any emails coming to your staff from 
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your competitors could always be deleted (blacklisted) regardless of the 
content being deemed spam or whether it carries a virus or not!  

In order to provide a 'totally flexible' mechanism for the administrator to 
add special rules appropriate to his site, user community and overall 
email environment, Equiinet have created what is known as a "Policy 
Tree". This is radically different to anything else seen before on the 
Admin control interface and at first sight looks a bit daunting. However if 
you can follow a flow chart - you can follow a Policy Tree and alter it for 
your applications! 
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 Email Policy Controls 

Email Filter Settings command - Email Filter policy configura-
tion 
 

This screen defines two elements: 

• The overall policy to use when an email arrives. 
The default policy called start contains other policies for the dif-
ferent interfaces and for controlling Spam, Viruses etc. 

• The remind policy, which is used each day as regards to emails 
that are quarantined on the unit. The default policy will send 
emails to the administrator and delete quarantined emails after 
30 days. 
 

These policies may be copied and then modified with actions defined by 
you. 
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There are also two entry fields: 

First field:  
The field's setting applies to emails for which the decision has been al-
ready made to either delivery or to discard them. It signifies the amount 
of time for which the emails header and body are kept on the system in 
Review and Learn.  

Second field:  
This field applies to the amount of time for which email headers are kept 
on the system in the Review and Learn section. During this time the ad-
ministrator can still remove from the unit’s memory what it learned from 
an email’s header and body. However, the NetPilot can only be retrained 
on the emails headers as the body would have been deleted after the 
time entered in the first field. 

If the administrator changes the second field to less then 30 days the 
monthly report can not be made/created as there will not be 30 days of 
data left!  

As this field is related to the functionality of Anti-Spam it is only shown 
when Anti-Spam is enabled. 

Email Filter Settings command - Reset 

 
This option under Email filter policy > Settings > Reset removes 
changes you have made to the Policy Tree, by taking it back to the rec-
ommended (factory default) settings. It will also remove any changes you 
made to the following areas: 

Email - Email administrator 
Email - Email footer 
Email - Configure transfer - Outgoing mail servers - Copy mail messages  
Email - Virus - Virus scanning configuration 
Email - Virus - Virus redirection settings 
Email - Spam - Spam assessment 
Email - Spam - Spam threshold 
Email filter policy - Settings - Email filter policy configuration 
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Email filter policy - Policy tree 
Email filter policy - Advanced - Edit policies 
Email filter policy - Advanced - Edit patterns 
Email filter policy - Advanced - Edit actions 
Email filter policy - Advanced - Edit templates 

 

 
 

 



Email Policy Controls 
 

 

68                  Getting Started – UTM Email 

Email Filter Settings command – Basic Email Tests 
 

This command in Email filter policy > Settings > Basic test does basic 
checking on the construction of the various policies, which are located in 
the policy tree. It you modify these standard policies this test is automati-
cally run and a link is provided to it within pages where you are asked for 
a second time to confirm your changes. If a problem is discovered a 
warning in red will appear at the point at which it was found. 
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Policy Tree Screen 
 

This screen in Email filter policy > Policy tree gives a flow chart show-
ing how an incoming email will be handled. The blue, highlighted in bold 
policy links give the ability to modify individual elements of the policy 
tree.  

Each policy is a set of rules which depending on the conditions of the 
various tests and patterns matching an emails will result in actions be-
ing performed with that email.  
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Extending over the next two pages is the complete default policy named 
start. 

This policy contains a number of other policies, which are:  

• Virus policy –This policy has been positioned first as regardless 
of where the email came from and what other elements it con-
tains the important thing to check is whether it contains a virus 
before going any further. 

• Trusted policy – This is for interfaces on the NetPilot regarded 
as trusted i.e. normally including LAN1 the local LAN with the or-
ganisations own PCs and servers etc.  

• Untrusted policy – This is for interfaces on the NetPilot re-
garded as Untrusted i.e. WAN ports normally including LAN2. It 
will include an Anti-Spam policy if Anti-Spam has been enabled. 

• Remind Policy – This defines what to do with emails that have 
been quarantined by the above policies. The default policy re-
mind will send emails to the administrator and delete quaran-
tined email after 30 days.  
 

See the default Policy Tree over the next 2 pages 
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Viewing and modifying Policy Tree elements 
 

By clicking on Start you can view and then modify rules within this de-
fault policy. The default contents of the Start policy are shown below: 

 
 



Email Policy Controls 
 

 

74                  Getting Started – UTM Email 

Quarantine Screen 
The Quarantine screen Email filter policy > Quarantine shows a sum-
mary of emails that have been quarantined. The Admin user can deal 
with them by either selecting View, Perform action or Set rule.  

 
 

In the example below many spam emails and an email containing a virus 
have been quarantined. 
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Quarantine - View Option 
By selecting the View option in the last example screen shot the email 
header of the virus infected email can be examined directly as only one 
email is present.  

 
The body of the email actually discloses the fact that a Virus test was 
being conducted. The section Extra Headers shows what the Anti-Virus 
system discovered – that the EICAR-AV-Test virus had been received. 
 

 
Even further down the View output a drop down box is offered to the 
administrator. The options available include a default recommended ac-
tion – which is to discard silently (delete without indicating to either the 
sender or intended recipient). Alternatives might be to forward on to the 
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sender as it is a harmless test virus or to return the email to the sender – 
showing that the AV testing had work by trapping and returning.    

 
If more then one email is being held in the quarantine area then the 
emails will be ordered in a list, displaying their subject and sender once 
View has been selected. 
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The Admin user can perform the following: 

• View all emails in a more detailed view by clicking on detailed 
view 

• View specific emails by selecting an email’s underlined subject in 
a very detailed view and examine the email header  

• Apply recommended actions to all emails or change recom-
mended action to: deliver incoming, learn ham and deliver, do 
nothing. All choices will be applied once OK is selected. 
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Quarantine – Perform Action Option 
 

Once Perform Action has been selected from the radio button set in the 
main Quarantine screen the user is then progressed to the next page 
where he can select Actions to perform from a drop down menu. The 
selected action will be applied to all emails selected in the main Quaran-
tine screen and the number of emails affected is also displayed in the 
perform action screen. Options for actions are the same as offered from 
the bottom of the View screen. 

 
 

On finding a Virus, the virus policy defaults are to email the administra-
tion a warning that a virus has been found. The warning email also in-
cludes a link for the Admin user to click on and directly take action e.g. 
discard. 

See next example:   
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In addition if the Administrator does not undertake some action within the 
default one week period, warning emails will be sent reminding him to 
act. 
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Quarantine – Set Rule Option 
 

The final radio button control option from the Quarantine screen is to Set 
Rule. This offers the admin the ability to add its own rule for this type of 
incoming email.   
 
The position of the new rule in the existing Policy Tree is important, so a 
suitable place is suggested – but not necessarily where you want to lo-
cate it. Characteristics are also shown about the email, such as in the 
below example the detected virus type. The Admin could create for ex-
ample a rule whereby if the EICAR test virus is seen again it is immedi-
ately returned to sender thus saving the administrator the need to take 
further Quarantine action in the future.   
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Review and Learn Screen 
The Review and Learn screens in Email filter policy > Review and 
learn are all about Administrator’s control of classifying emails as SPAM 
or HAM, so that the Bayesian Spam filter can be trained to know in future 
how to deal with similar emails.  

The main screen shows a summary of emails that have passed through 
the system as they have been discarded or delivered. The Admin user 
can go back and change how the system will deal with similar emails in 
the future by selecting either a mail category type or search headers for 
a particular pattern and then reviewing the particular emails. 

The system keeps details on the last 10,000 emails. In the example be-
low only 4 emails have been learnt, so we could immediately view all 4 
messages. 
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Review and Learn  – View Option 
By selecting the View option a summary of the relevant set of emails is 
displayed as below. 

By clicking on the links to the email, the Admin user can inspect the 
header of an individual email. 

 
By selecting one of the boxes along side the individual emails – the 
Admin user can select a group of emails and reclassify them by selecting 
Learn as Spam or Learn Ham and deliver, if they believe these emails 
have been classified wrongly. Other options which can be selected are 
Do nothing or Deliver incoming. All choices will be applied on OK. 
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Review and Learn  – Set rule 

The admin user can also set a rule for emails stored in Review and 
Learn.  
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Advanced Email Policy Screen 
The Advanced section under EFP shows a collection of links to options 
which allow the administrator to change and/or create new features of 
the Email Policy Filter.  

Advanced – Edit Policies Option 
By selecting the Edit option a policy can be examined and edited. 

 
In the example below the Remind policy is being examined. The policy 
contains two rules. The Admin user could choose to add new rules, or 
modify the existing rules which contain actions and patterns. 
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Advanced – Edit Patterns Option  
 
By selecting the Edit option existing patterns can be examined and/or 
modified. Some system patterns are locked, so copying to create a new 
similar pattern is required.  
   

 
The Quarantine age pattern has been copied in the below example and 
the default pattern is set to look for an age of one day. To make a new 
pattern to match 3 days the value of the pattern needs to be changed 
from 1 to 3. 
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Advanced – Edit Actions Option 
 
By selecting the Edit option existing actions can be examined and/or 
modified. Some system actions are locked, so copying to create a new, 
similar action is required. Administrator actions created in this way will be 
prefixed with an “*”.  
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In the example below a copy of the Remind action has been created and 
the field Send to Recipient has been modified from nothing to one-
week reminder. 
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Advanced – Edit Templates Option 
 
Templates define how emails will look when they are sent to Admin, 
Sender or Recipient, etc. The Admin user can create new Templates by 
copying and then editing default system templates – which are deliber-
ately locked to ensure the most frequently used templates are not inad-
vertently destroyed by the Administrator.  

 
 

The following example shows how to view a locked system template 
called virus held warning. This Template is used in the event that a vi-
rus is found, and if the default action is in place, a warning email based 
on that template is send to the Admin user. 
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The template definition is made up of plain text and a number of control 
strings which start with $. 

 

The full definition of what the $control strings mean is shown next. 
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Advanced – Pattern Test Option 
 
By selecting the Pattern test option the modified Email Policy rules can 
be tested against files of which is known which patterns they have trig-
gered previously. 
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Modifying the Default Policy Tree – Examples 
 
Example1: Modifying forward a copy policy 
Below is a simple example of how the tree can be changed by clicking 
directly onto the tree and going directly to the commands that affect its 
option. 
The first rule in the default tree is forward a copy – which is set to off as 
default. Click on this link. 

 

 
 
 
The next screen shows that there is a separate page for configuring the 
action associated with this rule. Click on the link in this screen. 
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We then arrive at the Outgoing mail Servers screen which we could 
have directly entered via Email > Configure Transfer > Outgoing Mail 
servers options. Entering a value in the third box and clicking OK will 
affect the Policy Tree as shown next. 

 
Returning to the Policy Tree screen will show that the forward a copy 
action has changed and is now operational. 
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Example2: Refining Anti-Spam handling 
 

The following example shows the addition of rules to Untrusted policy 
(for email coming from the WAN interface) achieving that emails with 
Spam scores under 1.0 and 1.0 itself will be passed though to the recipi-
ent – but with a revised footer giving them the ability to reclassify from a 
link added to the email footer. In addition anything scoring above 1.0 but 
less that 5.0 or 5.0 itself will be quarantined for Admin reclassification. 
Anything above 5.0 will be learnt as Spam and then discarded (deleted). 

 

The modified Untrusted policy is shown below: 
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By clicking on Spam Policy link in the Policy Tree it is possible to view 
the rules settings of the Policy. (Admin can also change the order of 
rules, add rules, delete rules or modify them). 
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The policy shows that under Email / Spam / Spam Threshold the Dis-
card Threshold option has been set to 5, while the Suspect Threshold 
has been set to 1 and the action for emails scoring above 1 (and below 
5) is to Quarantine. 
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To revise the footer the administrator needs firstly to create a new tem-
plate, which will amend the footer. The new template, once created will 
appear with an “*” in the list of templates denoting it is an Admin created 
template.  

 
 

The new template is shown below. It defines that the headers, and extra 
headers, and body should appear in the normal way. The extra items 
added are a line of dashes to denote this is the start of a footer, and the 
addition of a link to the receiving unit to enable the recipient to reclassify 
the email as Spam if required. 
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The action deliver email with reclassify needs to uses the Admin cre-
ated template. The action will apply the new template to classified email. 

 
 

In the last step the new policy needs to be added to the bottom of the 
Untrusted policy tree.  A ‘How to’ document in our SmartStore also de-
scribes the above example in more detail under 
http://smartstore.equiinet.net/index.asp?195319.
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An example of the latter part of a Spam email to which the above action 
has been applied shows a footer based on the created template which 
includes the reclassify link. 
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